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Voorwoord

Deze handleiding omvat uitleg over het opzetten van een i-Tree Eco project
‘Complete inventory’.

i-Tree Eco is een Engelstalig programma, in deze handleiding worden de
Engelse termen overgenomen zodat ze terug te vinden zijn in i-Tree Eco.

Voorbereiding
Maak alvast een projectmap aan op de computer, waar alle i-Tree Eco
bestanden bij elkaar komen te staan. De volgende mappen raden wij aan;
= |-Tree Eco
o Origineel/ moederbestand
- Plaats voor boomgegevens uit bijv. bomenbestand als

back up
o Input
- Ruimte voor o.a. werkdocument, boompunten met
i-Tree Eco opnamekenmerken
o Output

- Plaats voor i-Tree Eco template voor uitkomst data

Het programma i-Tree Eco geeft per onderdeel uitleg over de te nemen stappen
en waar bepaalde termen voor staan, middels een hulp box (links van de Ul).
Neem dit door als je even niet meer weet waar je in het programma bent en wat
je moet doen.

Voordat je verder gaat met de stappen in deze handleiding dient het te
gebruiken bomenbestand gereed te zijn gemaakt voor het importeren in
i-Tree Eco.

i-Tree Eco slaat wijzigingen automatisch op.
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Stap 1. i-Tree Eco openen

= Starti-Tree Eco via jou desktop
= Lees altijd het nieuwsbericht zodat je weet wat er eventueel is
veranderd ten opzichte van een oudere versie.

i-Tree Eco

‘ Project Configuration ~ Data  View  Reports  Forecast | Support

B

User  User  Video
Manual Guides~ Learning

Help

To get started, go to the Fil
following options:

s New Project —to
s Open Project —tc
s Open Example Pr

an example proje

Choose from the available
bar to access the different
Within each tab, you can
or buttons in the ribbon a
choose will become availi
right.

=g

$RY * U

What's new in i-Tree Eco

The most recent version of i-Tree Eco offers several upgrades over previous version, including the following:

*  Mexico and Europe Integration - Eco now works seamlessly in many Mexican and European cities. Users can select numerous locations throughout Mexico and Europe
for the same automated processing available in the US, Canada, Australia, and the UK. Not all cities may be available due to limitations on data availability. Users
can typically select the closest, representative location, or submit new cities for future i-Tree integration by providing local data and information needed through i-
Tree Database, https://www.itreetools.org/news/2016news/10articles/database.php.

*  New Global Cities - The i-Tree User community has provided data through i-Tree Database to facilitate integration of numerous international cities throughout Eurcpe,
Asia, and Latin America for automated processing in Eco. See the New City List for internationzl locations and data availability:

(http:/ fwww itreetools.orgfresources/content/iTreeDatabase NewCitylist x|sx).

s  Capturing Coordinate Data - There are now three options for capturing coordinate data while using the Mobile Data Collector web app: manually type in coordinates,
use the device GPS, or tap a location on the map that is displayed through a data connection. To read more about this, please see this guide:
https://www.itreetools.org/resources/manuals/Ecové ManualsGuides/EcoveGuide MobileDataCollector-GPS.pdf

s New Reports - Newer reports include Plot, Tree and Shrub Comments, and the Air Quality Health impacts and Values report is split into four reports (By Tree, By Shrub,
By Grass, Summary). Some reports are limited to US locations and plot-based projects.

*  Weather and Pollution Data Availability - 2016 is now included as well.

* US. Carbon and CO; dollar valuations have been updated to:

s  Carbon price per 1 metric ton is $188.
*  CO; equivalent price per 1 metric ton is $188/3.67 or approximately $51.22.
*  These values are taken from the Social Cost of Carbon (https://www epa gov/sites/production/files/2016-12 /documents/sc_co2 tsd august 2016 pdf) and
are adjusted to 2018 dollars.
*  Eco previously used $145.95 per metric ton of carbon.

To read all recent changes made to i-Tree Eco, please see the change log: https://www.itreetools.org/rescurces contenf/iTree suite change log.pdf

Show this dialog when the application launches

Homly located
antify forest

File menu in the

ab for more
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Stap 2. Nieuw project aanmaken

= Ga naar File (links bovenin bij de linttabbladen)
= Selecteer ‘New Project’ in het lint

= Een pop-up verschijnt: Kies het project type “Complete Inventory” en klik op OK
= In het nieuw opgekomen venster kun je het project opslaan in de gewenste map

et By
.o smalle

Export —tg
Editing Mg

*IMPORTA
afteryou ¢
zreyed oui

When a pr|
oy clicking
at that tim
your data 1

Motes:
¥ Functi
about |

Please select the project type: | Complete Inventory w

Complete Inventory

A complete inventory project is one in which you collect data
for all of the trees in your study area. This type of project is
most applicable to the analysis of a small, discrete area,
such as a residential parcel or a commerical property. Keep
in mind, however, that data collection on each tree is
intensive, and sites with many trees will be very time
consuming.

If you are planning to do a complete inventory project, be
sure that it is selected in the drop-down list above, and then
click OK.

If you are not sure that this project type is the right choice for
vou, select one of the other project types from the drop-down

list to see a description of the other opticns.

This type of project is also suitahle for tree planting-only

projects with forecasting.
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_=rne Plots Export

File > New Project
Stap 3 . P rOJ eCtg egeve nS I nVU | |e n ou | Enter project overview information and click OK to save it or Cancel to quit thit
Project Settings  |ocation Data Collection Options
I 1 2
& . 3 ) . L . me What name would you like to give your new project?
Het scherm bestaat uit drie tabbladen, vul deze in voor dat je op oké klikt. De ne
inhoud per tabblad staat hieronder uiteengezet: Project Name: [Voorbeeld |
. . wr " .
Tabblad 11 PrOjeCt Settlngs u"sed What name would you like to give your series?
. . . . . . . 5 or
Algemene informatie zoals naamgeving van project. Gebruik een titel en subtitel time SeriesName: [10 Bomer] |
om je project eenvoudig terug te vinden. Voeg vervolgens het betreffende '
jaartal in en ga naar tabblad 2. ) Please specify the series year for your project:
Series Year: | 2020 |
5
Please specify the following inventory information:
1are Inventory Type: Complete Inventory
th
d
. project overview information and click OK to save it or Cancel to quit this process.
Tabblad 2; LOCatiOn coject Settings Location  Data Collection Options
Nat|0n : Land ) Please select a location to use for your project:
State : Noord, oost, zuid of west Nederland Hint Use the Delete hey to cear a selectian.
Country Prov'nc'e Of Vel|lghe|deegIO :titjt:l!;i::;;:;:r::ﬂna::r::lc:r:tj;r;:[;Eaa\;a”i:;lslle due to limitations of information provided by cooperators.
Place : Stad
Urban? : Stedelijk gebied ja of nee Nation: Netherlands | Please check adjacent Counties/
Population : Aantal inwoners van de gemeente state: Oost-Nederland - '
County: Veluwe ~
Weather & Pollution Year : Kies een jaar met weather and pollution data, Place Apeldoorn 5
_ voorkeu_r VOOor recente gegevens 15 the study area Urban?
Weather station : Open hiervoor de kaart door op ‘Show map’ te Population: [123456
klikken en kies een weerstation met ten minste Fair ) ] _
completeness en bij voorkeur Good completeness. Please speciy the following years for your project:
Is er geen goed station in de buurt? Kies er één in Weather & Pallution Year: |2015 (Weather and Pollution) | NOte: Precipitation values outsich
een Soortgelljke OmgeVIng. Please select a weather station to use for your project:
Weather Station: Show Map
tdverde Pagina 6 van 18
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Tabblad 3; Data collection Options
Dit tabblad wordt ingevuld aan de hand van de beschikbare boomgegevens die
je gaat gebruiken.

LET OP: zet de units op Metric! Dit kan je later niet meer aanpassen.

Vink de gegevens aan die van toepassing en beschikbaar zijn voor jou project.
Bij Crown Health kies je de optie condition als je met conditieklassen werkt.

Uitleg van de mogelijke selectievelden staat in hetzelfde tabblad onderaan. Na
het aanvinken klik je op OK rechtsboven.

e > New Project

Enter project overview information and click OK to save it or Cancel to quit this process. 0K Cance

Project Settings  Location Data Collection Options

What units will you be using during your data collection? ®  These fields MUST be collected!
(@] English This option cannot be changed once a project has been created. B These fields are optional and HIGHLY RECOMMENDED to improve model estimations.
B These fields are opticnal
® Metric
TREE INFORMATION
Minimum Requirements General Site Fields Tree Detail Fields Management Fields
Species [] Tree address [ Total tree height [] Maintenance recommended
DEH [ Land Use [ crown size [] Maintenance task
Measured v O strata/Area . HEiE:‘TD“VETDPb O sidewalk conflict
. . . Height to crown base
+ Check this box if you know your project * i i
e il your proj o Crown width [ utility conflict
+ See Project & Strata Area to configure = Percent crown missing [ Pests (IPED)
description and area. [ Crown Health {requires 5 fields for each of the following)
[ status Dishack = Sign & symptoms of tree stress
* Sign & symptoms of foliage/twigs
[J Street tree/non-street tree Condition + Sign & symptoms of branches/bole

Default non-street tree [ user Tree ID

(Can be used to track custom tree ID)

[ Crown light exposure

[ Map (GPS) coordinates [ Energy (building interactions)

[ Public/private = Distance to building

= Direction to building

(processed for USA, CAN, MEX, AUS, UK,
and select countries in Europe only)

Default Public

tdverde
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Onderstaande afbeelding is een samenvatting van de selectievelden die je wel/
niet gaat gebruiken en wat dan wel/ niet mogelijk is om te berekenen.

Klik op OK om verder te gaan.

Nu is het project aangemaakt en weet i-Tree Eco met welke gegevens je wilt

gaan rekenen.

~ Report Availability —

[=- Formatted Reports
h ‘ i Witten Report

- Composition and Structure
- Structure Summary

i i By Stratum and Species

[=- Population Summary
5 By Species
- By Stratum
- By Stratum per Linit Area
ured Public and Private by Stratum
- Street Trees by Stratum

- Species Distrbution
- By DBH Class {chart)
- By DBH Class {vertical table)

By DBH Class thorizontal table)

- By DBH Class and Stratum (vertical table)
- By DBH Class and Stratum (horizontal table)
- Importance Values

‘... By Species
[=)- Diversity Indices (Unavailable for this project type or location)

By Stratum {Unavailable for this project type or location)
—- Species Range
i Native Status by Stratum
- Condtion

By Stratum and Species
= Crown Heatth

1 thre | - By Species

tego

]

>

*

D Some reports will be unavailable as indicated in red below. These require Data Collection Options you have not selected.

~

W

 Fie Click OK to proceed or Cancel to retum to Data Collection Options.

Cancel

m Tt

m Tt

height

to live t
Lo crow
nidth

crown

alth
k
on

't expos
ilding ir
e to bui
ntobu

for Us
countri

m Field Two name:
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Stap 4 Project & Strata Area

In dit menu kan je locaties van je projectgebied gaan toevoegen. Denk hierbij
aan wijk, buurt of straatnamen. Het is ook mogelijk om een opdeling te maken
tussen bijvoorbeeld binnen/ buiten de bebouwde kom. In het kort kan je hier de
bomen opdelen in groepen voor je analyse. Het is dus belangrijk dat je op
voorhand weet wat je wilt gaan analyseren.

Om deze opdeling te maken klik je op het linttabblad project configuratie en
vervolgens op Project & Strata Area in het lint.

Voer in de verschenen tabel de gegevens.

LET OP: voor de kolommen in deze tabel geldt een invulverplichting.

Indien bekend is het mogelijk om het aantal hectare van het gebied door te
geven, wanneer dit niet bekend is vul de kolom: Area(ha) in als 1.

Wanneer de bomen zijn toegevoegd, na stap 5, zie je het aantal bomen per

strata onder dit tabblad terug.

Klik na het invullen op OK (rechtsboven)

~roject Configuration

B

=R

View Reports Forecast

Doe L X

Support

Land Crown Project & New Undo Redo Restore Delete Editing
1 Use Health Strata Area Defaults Mode: On
Define Data Fields rt Actions

onfiguration > Project & Strata Area

:«ct & Strata Area field seen in the action panel to the right is

u can enter the area of your project or strata. This function
ws you to stratify (subdivide) your study area into smaller

ch as land use classes or counties. One reason that you might
tratify your project is so that you can compare urban forest
stween each stratum.

cide not to stratify your project, then you will be working with
strata that encompasses your entire study area. Whether you
3 stratify your complete inventory or not, follow the

ate steps below.

ANT*
tion will not be available if you did not set “Strata/Area”

id ven@
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Ll

Project Configuration > Project & Strata Area

Strata & Zones: modify the values below as needed.

Nots: Arsa values sntered here are critical to the estimates generated by the modeling process and various areg-based reports. For clegrer reporting, delete any st

Total Area (ha): 2,00 Total #ofTrees: 0

Description Abbreviation

Area (ha)

# of Trees
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Stap 5. Boomgegevens importeren

Voor deze stap dienen de boomgegevens gereed te staan in een_Excel
document. De titels van de kolommen hoeven niet overeen te komen met de
toegepaste benaming in i-Tree Eco. Deze koppel je aan elkaar tijdens het
importeer proces. Om de boomgegevens te importeren ga naar het linttabblad
Data (1) en klik op Trees (2) (zie groene cirkels in afbeelding).

Als je enkele bomen wilt doorrekenen kan je deze ook direct invullen in de nu
verschenen invoervelden i.p.v. het hieronder beschreven importeerproces.
Neem bij voor het importeren de volgende stappen.

= Klik op Import (rode cirkel) in het lint

= Klik op Next

= Selecteer het bestand dat je wilt importeren, als de eerste rij
kolomtitels bevat vink je dit aan (checkbox: first row contains column
headers). Vervolgens klik je op Next.

- Data Import Wizard —

Welcome to the i-Tree Eco Data Import Wiz

This wizard will guide you through the steps needed to import your data into Eco.

Before you proceed you should make sure any data being imported is formatted consistently. If
importing from Microsoft Excel, each column should be formatted according to the type of data it
contains; mixing data types within a column may cause inconsistent results. For example,
Microsoft Excel often displays data as numbers but actually formats them as text or string data.
This will become apparent during the import process and should be fixed in Excel beforehand.

Special Note: If you have empty cells in any of the first 10 rows, make sure you put appropriate
“filler” values in them so that their data type can be inferred correctly. Example: Place 0's in
numeric columns so that those cells are not improperly read as text values.

Due to memory limitations, you may need to break large data sets into smaller batches.

‘Where applicable, you can import your own |D numbers into the User ID field so you can cross
reference your data later.

Avideo tutorial about the process is
mariZzhE uSg

ilable at: hitp:/'www itreetools org/mediawatch.php?

< Back Neat =

idverde N
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‘ Project Configuration Data View Reporis Forecast Support
{ — | 0 - |
L= VM LS 2@
bmit  Retrieve Paper\ Import R Trees gheck @ Benefit Annual | DBH Crown | CSV KMl
Mohile from Maobile | Form ZDEG Prices Costs Health
3 Inventory Datal Inventory Value | Report Classes Export

>Trees

Trees table seen in the action panel to the right displays the tree

a that you collected in the field (see Notes below). This is where you
enter your tree data manually or edit your previcusly added or
orted data. While working in this table, you may use the tools in the

ions group to help manually enter new data or edit data that has

an existing inventory? The Import function allows you to

il

~

Data > Inventory D:

Required inputs MUST be

D

Stratum

Select the file containing the data you'd like to import
File Name: R:\d_Marketing.20204Evenementen' 728200048 AM i-Tree masterc] Browse
Worksheet or Range: |Worksheet: “Voorbeeld bomens’ w |
[ First row contains column headers.
Pand DBH - Totale Top hoogt
ID | Stratum | Boomsoort e 1 Conditie | hoogte levende
ftm) (m} kroon (m)
k|1 Staat 1 Quercus rabur Residential |40 92 20 20
2 Staat 1 Quercus robur Residential |40 92 20 20
3 Staat 1 Quercus robur Residential | 40 72 20 20
4 Staat 1 Quercus robur Residential |40 72 20 20
5 Staat 1 CQuercus robur Residential | 40 47 20 18
& Straat 2 Ulmus x hollandica | Residential |40 92 15 15
7 Straat 2 Ulmus x hollandica | Residential | 40 52 15 15
8 Straat 2 Ulmus x hollandica | Residential |40 72 15 15
9 Straat 2 Ulmus x hollandica | Residential | 40 72 15 15
10 | Straat 2 Ulmus x hollandica | Residential | 40 47 15 13
| <Back || MNet> | | canr
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ard — ] X

Select an inventory column below and then define how to import it into Eco.
Rep for EACH col BEFORE clicking Next.

= Vervolgens gaan we de kolommen koppelen aan de betreffende i-Tree Eco velden. D Stratum Boomsoort  [NETEITS DBH 1 (cm) ol
LET OP: Eerst alle gewenste kolommen koppelen, dan pas op Next klikken. .
Door te klikken op een kolom selecteer je deze en wordt de kolom blauw. Sreat 1 Guercus obur R “ i
= Voor het koppelen van de i-Tree Eco Velden volg de volgende stappen . ' v 2
) 2 Straat 1 e Residential 40 72
—>1. Your source column = jouw gekozen kolomtitel 1 P : Residential 0 =
2. Eco field = i-Tree Eco kolomtitel 5 Strast 1 G . Residentia a0 4
- 3. Field type = nadere definiéring 6 Siraat 2 ! L2l Fesidential 40 %2
Bijvoorbee'd : 7 Straat 2 u I Residential 40 92
o ID 9 ID 8 Straat 2 U =l Residential 40 72
o Stratum (wijk/straat)> Stratum = Description s a2 omus xhelends M B =
g N . 1 Straat 2 Ulmus x hollandica R3EEREGIE 40 47 ¥
o Boomsoort > Species - ScientificName < >
O

Etc.

° Designates a required Eco Field that must be mapped. Invalid or unmatched values for required fields will
result in records that cannet be imported - see Support > User Guides for details.

B 5 5 n Your Source Column:  Boomsoort Eco Field: | Species” w
LET OP: Wanneer er een uitroepteken ontstaat zit er een fout in de benaming. | |‘

Vink het volgende dan aan: | need to map my source column values to the
Eco field values. Dit komt bij het aanvinken later terug in de wizard. Bij fouten
waarbij veel verschillende waardes worden gegeven zoals bij boomsoort, kan
het aan te raden zijn deze informatie in het Excel bestand aan te passen.
Vervolgens dient de stap van het importeren te worden herhaald.

il [[] I need to map my source column values to the Eco field

=
V. r— }
values. (This comes later.) Field Type: |ScaertﬁcNa-ne >

< Back . Next > |_Cancel

Select a row to begin matching data:
Your Field

Eco Field

[» | Straatboom Street Tree? 1of 1values ma...

= Nadat alle kolommen zijn toegewezen klik je op_Next
LET OP: bij het verschijnen van uitroeptekens in de kolommen bij het
toewijzen herkent i-Tree de ingevulde gegevens niet. Volg bij
uitroeptekens de volgende stap.

= Wanneer in het vorige scherm | need to map my source column Yes
values tot he Eco filed values is aangevinkt, krijg je het scherm
waarin je de kolomdata overeen zet met i-Tree Eco velden

= Klik op Next als je klaar bent met deze stap of dit niet hebt aangevinkt.

Match your data by selecting the row and then clicking its empty Eco Value
cell. Either enter a value or. for some data. find the best match in the pop-up
list (large lists and selections from them may take a few moments to display)

Eco Value

Your Value

idverde N
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= Vervolgens krijg je een samenvatting van de boomdata dat je gaat o

importeren. Bomen met onvoldoende informatie worden niet <ecords before processing:
geimporteerd. Controleer het aantal bomen welke je wilt meenemen in Existing records in table: 0
de berekening, wijkt dit af? Dan kan je bgter in je 'Excel* de gegevens Results of processed data:
controleren op fouten en het proces opnieuw beginnen. Wanneer klaar Total records andyzedfor import: 10
kllk Op —FInISh' Records that cannot be impoted: 0

Records to be imported: 10
Records to be imported:

v Stratum Species Land Use DBH 1 (cm) E[}?]";r;
1| Straat 1 Quercus robur Residential
* Voor deze handleiding gaan we uit van een bomenbestand van tenminste 2|Sraat1 | Quercus robur Residenti 40|92
10.000 bomen of meer. Gaat het om een kleine groep bomen (<1.000) dan kan 3|Sraat1 | Quercus robur Residenti 40|72
je de fouten wijzigen in het voorgaande proces. Hier kom je terug door op Back 4|Stract1 | Quercus robur Residential 40|72
te klikken. Verbeter hier de kolommen met een foutieve waarde (uitroepteken) 5| Sreat 1 |Queraus robur Residential 40147
6 | Straat 2 Ulmus x hollandica Residential 40|92

met een waarde welke i-Tree Eco herkent. =

Click Finish to complete the import process or click Back to revise your settings and reprocess your data.

Please review your data after clicking Finish. Additional modffications may be required to meet your proje
specfic requirements.

< Back Finish

tdverde . Pagina 12 van 18
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Optioneel; Veldopname met telefoon/tablet

Wanneer een project is aangemaakt kan je bij Data (in het lint) kiezen voor
Submit to Mobile. Dan krijg je een link per e-mail naar een webpagina en kan je
net als GIS de bomen in het veld opnemen met een telefoon of tablet. Later kan
je de gegevens vanaf je telefoon exporteren en importeren in i-Tree Eco.

Nadeel; Je moet eerst een i-Tree Eco project aanmaken. Dit staat dus los van
het beheersysteem.

Voordeel: je hoeft geen eigen opname module te bouwen en je kan de
gegevens in i-Tree Eco in kaart brengen d.m.v. codrdinaten latitude en
longitude

Qonfiguration | Data  View  Reports  Forecsst  Support

SRR R

Submit  Retrieve baper | Import | Trees Check | Benefit Annual | DBH Crown | CSV  KML Editing
0 Mobile from Mobilggl Form Data Prices Costs Health Mode: On

ollection Inventory Data! Inventory Value | Report Classes Export

-

Data > Data Collection > Submit to Mobile

Submit Project configuration for Mobile Data Collection
[ Select All # None

Oof 0 Trees selected  Egil Address |

Land

Use Photo ID DBH 1 (cm)

D Stratum Crew Survey Date Species

v ETsEFYAE Y Ay

TESE

SR

idverde N
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DBH 1: pBH | Confim Emai |

Height {m) M Password |

Confirm Password |

An email with instructions for accessing the i-Tree Eco mabile collection appli
will be sent to the address provided.

The supplied password restricts access to the data submitted from the i-Tree

mobile collection application.
Submit Pr

Previous Submissions:
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Stap 6. Boomgegevens controleren en opsturen

De bomen zijn geimporteerd in i-Tree Eco en zijn terug te vinden via het lint bij
Data - Trees. In dit overzicht kan je nog wijzigingen aanbrengen bij de
boomgegevens.

Heb je in het begin bij project configuration een parameter te veel of te weinig
geselecteerd? Dan kan je dit vooralsnog bij project configuration aan of uit
vinken (geldt niet voor alle kolommen). Bij het tabblad_Data verdwijnt of
verschijnt dan de desbetreffende kolom.

,.ohﬁguratioﬂ Datz View Reports Forecast Support

B0 @M% $§ T ad 1H® L X

e | Paper | Import | Trees Check | Benefit Annual DBH Crown | CSV KML | Wew Undo Redo Restore Delete Editing

bile | Form | Data Prices  Costs Health | | Defaults | Mode: On |
Collection Inventory Datal Inventory Value | Report Classes Export Actions
1

~ | Data > Inventory Data > Trees
|

Required inputs MUST be completely and properly filled out. If you get stuck, you can delete the row and start over.

. Crown: Crown: Crowr
D | Stratum Spacies bas';d DBH 1 (cm) EB‘F'E’E@ ::m,'t (my | ToP Base Width
‘ 10 Height (m) | Height (m) | M/S (1
1 |Straat1 English oak (Quercus robur) Residential 400 0% - 95% 20,00 20,00 500 o Data | View  Reporfs - Forecast  Support
! 2| Staat 1 English oak {Quercus robur) Residertial 40,0 90% - 95% 20,00 20,00 500 E @ | % | ¥ sﬂ« o | @ @ | E’/ |
3 Straat 1 English oak {Quercus robury Residential 400 F0% - 75% 20,00 20,00 500 = 3 ] 7 :
- 5 - Paper | Import . Trees Ched Anua DBH Crown CSV  KML Editing
4 Straat 1 English oak (Quercus robury Residential 400 F0% - 75% 20,00 20.00 500 ‘ Er Data osts | Heatth | Mode: On |
5 Straat 1 English oak b Residential 40,0 45% - 50% 20,00 18,00 500 .
a‘ = ofsh o3k (Quercus robur) esicenta tion Inventory Data! InvEntory Value | Report Classes Export
[ Straat 2 Dutch elm {Uimus x hollandica) Residential 400 50% - 95% 15,00 15,00 500

Data > Inventory Value > Benefit Prices

Adjust your Benefit Prices (advanced users)

Notes:

« The Defoult values are those auailabis at the time of software installation.

= [f you leave @ vaiue biank, the most current defauit value will be used for processing and dispiayed in the foot
= Alternatively you may enter your own values if you know them.

= For future refersnce, use the C3V Export butfon in the ribbon above to save your current valuss BEFORE changi
= You may change the values below and update their associated Report outputs WITHOUT resubmitting your ent]

Voordat we de gegevens gaan controleren op juistheid van informatie dienen
wij de actuele wisselkoers door te geven:

= Klik op Benefit Prices in het lint onder het linttabblad data

= Klik op Get today’s rate

Measurement Units: YearUnit_Metric

Benefit Prices

Electricityin € (EUR)/kwh: | 015 | Defaut |

" K“k Op OK reChtSbOVen Heating in € (EUR)/therm: | 2.22| | Default ‘

Carbon in € (EUR)/metric ton: | 16066] | Defaut |

De andere Benefit Prices laten we voor wat het is. Dit gaan we naderhand Avoided Runoffin € (EURYm®: | 7502 [ Ddedt |
d .m.v. een Excel template berekenen/koppelen . For any prices left blank above, and other values such as Pollution Prices, the most current values will

A curreny exchange rate is needed to convert some of these prices:

Currency Exchange Rate: 1.00 US Dollar =€ (EUR) 0,88585 I Get today's rate I

tdverde . Pagina 14 van 18
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Naast Benefit Prices zijn er ook Annual Costs. Deze optie is interessant als je
beheermaatregelen wilt meenemen in je berekening en gaat werken met
toekomstvoorspellingen voor je beheerbegroting. Hier kan je eigen kengetallen
invullen. Voor een standaard berekening is dit niet noodzakelijk

idverde N
Bomendienst

Zion Inventory Data' Invento

Data View Reports Forecast Support

Paper | Import | Trees Check | Beng
Farm Data Price

DBH Crown
Health

= | Report Classes

T8O

CSV  KML
Mo

Export

Data > Inventory Value > Annual Costs

Enter the costs associated with your project

Notes:

= For futurs reference, use the CSV Export button in the ribbon above to save your currsnt val
= You may change the values below and update their gssocigted Report outputs WITHOUT res|

Public € (EUR) Private € (EUR)

Planting € (EUR): [ 0] 0|
Pruning € (EUR): [ 0] [}
Tree Removal € (EUR): | D| | 0|
Pest Control € (EUR): | 0] 0|
Irrigation € (EUR): [ 0] 0|
Repair € (EUR): [ 0] [}
Cleanup € (EUR): [ 0| 0|
I agal £ [FLIRI: [ nl | nl

Total € (EUR)
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Stap 7. Valideren van data

Het valideren van de gegevens doe je door op Check Data te klikken in
het lint. Er kunnen vervolgens twee verschillende schermen naar voren
komen. Zie hiervoor de onderstaande mogelijkheden

Scherm 1: DATA VALIDATION ERRORS
Dit scherm komt in beeld wanneer er fouten in het bestand zitten. Dit kan
variéren van te veel spaties in titels tot ongeldige stamdiameters
(max 254 cm diameter). De boom ID wordt vermeld waarbij een fout is
geconstateerd, hierdoor kan je deze vrij snel terugvinden in de lijst
met bomen.

= Klik op Close - Ja (als je de melding niet wilt bewaren)

We've checked your data and listed emors and wamings below_ FIRST. please
address any ermors listed - i-Tree Ecy .ot process your data with these emors. You
may wish to review the wamings and n.ake adjusments as necessary, although Eco will |
attempt to process your data in spite of these emmors.

If the issue perisists. it could be due to problems with other applications trying to
access the i-Tree Eco database. To make sure this is not the case, close Eco. restart
your computer, and try again. f the problem continues to occur, insufficient

pemmissions to properly mun Eco may be in place. In this case. pleasewurkuﬂhm"
department to set the proper permissions on your computer. Only if these actions fail to |
resolve the problem, please choose Pack ijed from the file menu and email your
project to info@itreetools org .

DATA VALIDATION ERRORS (These emors MUST be fixed to proceed):
ERROR: The project containg invalid settings:

Project name cannot end with spaces.
Goto Project Corfiguration = Project Definition = Project Settings to comect this emor.

Save Close

Scherm 2: All of your data appears to be free of errors and ready to be
submitted for processing.
Wanneer je dit scherm krijgt dan zijn de gegevens klaar om op te sturen.

idverde N
Bomendienst

il Data

S| P

Paper | Import

Forecast Support

S ;R &b

@enefit Annual | DBH Crown | CSY  KML Editing
Costs Health Mode: On

ventory Datal Inventory Value | Repaort Classes Export

Data > Inventory Value > Benefit Prices

Adjust your Benefit Prices (advanced users)

Notes:
= The Default values are those available at the tme of software installation.
= [f wou leave a value biank, the mast current default value will be used for processing and displayed in the footr
= Alternatively, you may enter your own vaiuss if you know them.
= For future reference, use the (5 Export button in the ribbon above to save pour current valuses BEFORE changi
= You may change the values below and update their associgted Report outputs WITHOUT resubmitting pour entl

Measurement Units: YearUnit_Metric

Benefit Prices
Electricity in € (EUR)/kWh: 0.1 Default
Heating in € (EUR)/therm: 222 Default
Carbon in € (EUR)/metric ton: 160,66 Default

Defautt

8 =

Avoided Runoff in € (EUR)/m?:
For any prices left blank above, and other values such as Pollution Prices, the most current values will

A curreny exchange rate is needed to convert some of these prices:

Currency Exchange Rate: 1.00 US Dallar = € (EUR) | D.EE‘}E-Bl | Get today's rate |

1
m
m

All of your data appears to be free of errors and ready to be Submitted
for Processing.

oK
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Data

Forecast

& T

Track & Written Compaosition Benefits Individual
trieve Results|| Report and Structure - and Costs~ Level Results~ A

Formatted Reports

View

Wanneer de gegevens klaar zijn om op te sturen (scherm 2) volg de volgende Support

stappen:
= Klik op Reports (in het lint onder linttabblad reports)
= Klik op Submit Data for Processing in het lint
Er verschijnt een informatieve tekst, klik op OK
Vul tenminste je e-mail adres in en klik op OK i B |
e Er verschijnt een export bevestiging, klik op OK " On this tab, you can send data, retrir

_«act Information *
/

Project:  (Voorbeeld . 10 Bomen. 2020)

Mame: |Dorien MNootgedagt |

Address: |
Phone: |{ ) - | ml |
Email: |dorien.noo'rtgedagt@bt|_nl | Email is critical for retuming
results. Please verfy that your
Confirm: |dorien.noo'rtgedagt@bt|.n| | email address is comect.
Motes:
OK || Cancel

De boomgegevens zijn opgestuurd en afhankelijk van het aantal projecten
in de wachtrij kan het een uur tot een werkdag duren voordat het resultaat
is op te halen.
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Stap 8. Resultaat ophalen

Per e-mail krijg je bericht of je het resultaat kan ‘ophalen’ in i-Tree Eco.

In het linttabblad Reports is nu de optie Track & Retrieve Results in het lint beschikbaar.

m Project Configuration Data View Reports Forecast Support

oject Submit Data Track & Written  Cormposition Benefits Individual

tadata for Processing Retrieve Results | Report and Structure » and Costs - Level Results» A

Formatted Reports

On this tab, you can send data, retris

Het ophalen van de gegevens kan enige tijd duren, vooral als het gaat om

een bomenbestand van meer dan 10.000 bomen. Nadat de gegevens

zijn opgehaald worden de opties in tabblad Reports gekleurd en kan je

deze selecteren. Hierin vind je de uitkomsten van de i-Tree Eco berekening

als ‘ruwe’ data. Een vervolg stap is de gewenste gegevens exporten voor het verder

analyseren en verwerken van resultaten.
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